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Introduction

How to use this manual Symbols used in the sequence of operation

This manual describes the basic
operation of the TPS400 Mining [MENU]  Press the [MENU] button

field programs. It shall be used
together with a TPS400

instrument. @D - @ Press the function button [F1-F4]
For detailed description about A

the whole functionality of the <« > Navigation keys

TPS400 instrument please refer v

to the TPS400 User Manual.

@ Repeat operation

@A User input is necessary

I? Important paragraphs which must be adhered to in
practice as they enable the product to be used in a
technically correct and efficient manner.

“ Introduction
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Peg Survey

Introduction

The application "Peg Survey" is
used to establish a forward peg
(point). It is used to control the
intermediate horizontal angle
between backsight and foresight
points. It also checks the
horizontal distances and heights
of the backsight and foresight
points. It computes the
coordinates of the foresight
point. "Peg Survey" allows users
to measure several sets in
different sequences. (The
quality of measurement is
controlled by the tolerances
which are set before starting
"Peg Survey").

Station

Backsight Point

Foresight Point

Mining_z01

Known:
» Coordinates of station

+ Coordinates of backsight
point

Unknown:
» Coordinates of foresight point
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Before starting Peg Survey

Data uploading using "Mining |g’ Uploading of fixpoint

Editor" coordinates, tolerances,
« Station coordinates sequence and number
(East, North, Height of sets is mandatory to
Grade elevation) enable the operation of
"Peg Survey".

» Backsight point coordinates
(East, North, Height,
Grade elevation)

» Tolerances, sequence,
number of sets

» Job definition

<=n

To create new jobs on
board the instrument, a
set of tolerance must be
available.
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Start and execution Peg Survey
* Press [MENU] and [F1] for RS CTeY  Choose "Start" by > Step 4 @EI=0|

programs. pressing [F4], then Set Point number
« Press [F1] for Peg Survey. enter point number .(PtID) and .
) (PtID) and instrument height
Select a job. instrument height (hi).
Confirm the set of (hi) for the station.
tolerances. The sign for the [EXIT] Leaves "Input
Ig instrument height Station" and returns
(hi) is normally to the start-up menu.
negative.
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Error messages

Station or BS point has no
valid coords !

* The point number entered is
not available in the internal
memory or it has invalid
coordinates.

7,

Re-enter point number

i>sten 3 |}

Sample dialog:

Survey will be
executed according to
the following settings:

BFFB

Number of sets:

One set means to measure two
times the backsight point and
two times the foresight point in
both faces.

The meaning of set is

described:
One Set
| Set
BS FS
Two Sets
BS FS =
=
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The user must complete
the number of sets as
preset in the tolerance
setting.

Peg Survey



Proceeding Peg Survey

Sequence: Sample dialog: Measure Backsight Point
Information about which
It defines the measuring backsight point the user has to
sequence. measure.
. Set 1
Options: of total 3 [OK] Leaves this dialog
- BFFB and proceed to the
Backsight-Foresight- measure dialog.
Foresight-Backsight
+ BFBF
Backsight-Foresight- Set 1 of total 3
Backsight-Foresight Start with measurement first set
- BBFF of three.
Backsight-Backsight-
Foresight-Foresight [OK] Leaves this dialog
and proceed to the
[OK] Leaves this dialog next dialog.
and proceed to the
next dialog.
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Proceeding Peg Survey, continued

Sample dialog:

1/3

PtID 150
Hz 5 98°12'45"
v 5 99°45'23"
hr B -1.263 m
HD : @ ee------ m

SEARCH |MEASURE

Enter the reflector
height (hr) for the
backsight point, if
required.

ERSIGTNE] Aim at backsight

point and measure.

[MEASURE] or [DIST]/[REC]
Angle and distance
measurements are
triggered and stored
in the internal
memory.

[SEARCH] Allows users to
search and choose a
different backsight
point.

[EXIT] Terminates the
program and returns

to the start-up menu.
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[OK]

Enter a desired
foresight point
number (PtID).

Saves the foresight
point number and
proceed to the
measure dialog.

Peg Survey



Proceeding Peg Survey, continued

Sample dialog:

Foresight Point 1/3
PtID : 151
Hz 5 198°12'45"
i 5 94°45'23"
hr B -1.632 m
HD : @ ee------ m

Enter the reflector
height (hr) for the
foresight point, if
required.

Aim at foresight
point and measure.

[MEASURE] or [DISTJ/[REC]

[EXIT]

e

=}
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Angle and distance
measurements are
triggered and stored
in the internal
memory.

Terminates the
program and returns

to the start-up menu.

Repeat ERSETNG
and EESICTEN until
all sets are
measured.

If the tolerances
after a set are not
met, the user has
the option to
continue with the
measuring or
rejecting the data.

[REJECT]

[ACCEPT]

Reject the
measurement and
measure the set
again.

Accept the result
and continue with
the next set.

Peg Survey



Results

Sample dialog:

TOLERANCES MET ! (PAGET)
dHz 00°00'25"
TolHz : 00°00'50"
dHD BS: 0.001 m
dHD FS: 0.003 m
TolHD : 0.006 m

[PAGE]

Sample dialog:

TOLERANCES MET ! (PAGE2)
dHD BS: 0.003 m
dHD FS: 0.001 m
TolH : 0.004 m
Set No: <ALL SETS>

Tolerances dialog:

* dHz: Residual on the
horizontal angle

* dHD: Residual on the
horizontal distance

« dH: Height residual

* TolHz, TolHD, TolH:
Tolerances horizon-
tal angle, horizontal
distance and height

* Set No: Set number
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[OK]

[EXIT]

Leaves this dialog
and proceed to the
result dialog.

Terminates the
measurement and
returns to the start-
up menu.

Peg Survey



Results, continued

Sample dialog:

TRAVERSE RESULT (PAGET1)
mHz 56°36'25"
mHDBS 56.465 m
mHBS 0.786 m
mHDFS 46.632 m
mHFS 1.236 m

[PAGE]

Sample dialog:

TRAVERSE RESULT (PAGE2)

Pt BS: 101
Pt FS: 102
mHz  : 56°36'25"
Seq BFFB
Num 2

Result dialog:

* mHz: Average
intermediate horizontal angle
between backsight point and
foresight point

* mHDBS/FS: Average

« mHBS/FS: Average height
(Backsight and Foresight)

+ Pt BS/IFS: Point number
(Backsight and Foresight)

; ; * Seq: Sequence
horizontal distance .
(Backsight and Foresight) * Num:  Number of sets
Backsight Point Station Foresight Point

Mining_z03
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Results, continued

Saving data

[OK]
[EXIT]

Quits the program.

Terminates the
measurement and
returns to the start-
up menu.

The following result data are
stored in the internal memory:

Result:
mHz:

mHD:

mH:
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Average
intermediate
horizontal angle
between backsight
point and foresight
point

Average horizontal
distance (backsight
and foresight)

Average height
(backsight and
foresight)

Residual:

dHz: Residual on the
horizontal angle

dHD: Residual on the
horizontal distance

dH: Height residual

Coordinates foresight point:

E: Easting

N: Northing

H: Height point
GrEl: Grade Elevation

Peg Survey



Front Line Peg

Introduction

The application "FLP" is used to
mark a new line peg (Front line
peg). This application is similar
to "Peg Survey" and there is
only one set of measurement
required.

For a more detail explanation of
"FLP", please refer to chapter
"Peg Survey".
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Introduction

"Grades" application is used to
mark gradelines along the side
walls of the mines (tunnels). It
allows users to input the slope
gradient and an offset
concerning the grade point. It
computes the stake out height
difference. The program allows
also to map the positions of the
grades points along the
gradelines.

Known:

» Coordinates and grade
elevation of station

» Coordinates and grade
elevation of backsight point

Backsight Point Station

Mining_z04

Foresight Point

H = Current height of
gradeline above mine floor

dH = New height difference
input for new gradeline

+ Slope gradient (station until
foresight point)

» Height difference (dH)
between current gradeline
and new gradeline
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Unknown:

» Stake out height difference
(dHgt) between measure
point and gradeline point

* Horizontal distance (dHD)
along the foresight line

Grades



Start and execution Grades

You can start Grades either by

selecting it in the program or
after measuring in the
application "Front Line Pag".

Ig When you start it from
programs you have to
enter station data and
measure to back- and
foresight point first.

Menu dialog of "FLP":

Sample dialog:

CONTINUE WITH ...

GRADES | OFFSET
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GRADES

Grade (1:x): 4.123
Grade (%) : 24.25 %
Grade (Ang): 13°38'00"

Direction : Down (-) 4»
Height 3 0.500 m

I? If the slope gradient
(station until foresight

point) is the same like
the slope gradient
(backsight point until
station) then continue

direct with ERSICToRY.

Grades



Start and execution Peg Survey, continued

ERSICT B Enter the slope

gradient

(proportion e.g.

1:150).

Slope gradient explained:

1WA Enter the height
difference.

Height difference explained:

'L\\.f’f’adeﬁne
1 O

150

Mining_z05

Station Foresight Point

Mining_z06

dH:

H: Current height of

gradeline above
mine floor

Height difference
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[EXIT]

[SET] Set the
entered values and
proceeds to the
gradeline marking
dialog.

Leaves the
application "Grades"
and return to the
menu dialog of
"FLP".

Grades



Gradeline Marking

Sample dialog:

GRADELINE MARKING
PtID: 100
dHgt: 0.552 m
dHD : 3.123 m
Hz 126°56'23"
HD 10.365 m

ERSICT WY Enter a desired point
number (PtID).

ERSICTRY  Aim at target point
and measure.

[MEASURE] or
[DIST)/[REC]
Measurement is
triggered and stored
in the internal
memory.

[PREV]
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Returns to the start
of "Grades"
application.

For a new definition
of slope gradient
and height
difference repeat

> Step 1 Wil
> Step 3§

[EXIT]

Leaves the
application "Grades"
and return to the
menu dialog of
"FLP".

Grades



Results

Grades computes the height difference (dHgt) between measure point and stake out point and the
horizontal distance (dHD) along the foresight line.

Height difference (dHgt) and horizontal distance (dHD) explained:

Station

Foresight Point

Mining_z07

Foresight

Point New

Gradeline
point

dHD

Station

Mining_z08
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Results, continued

Saving data

If the sign is
negative the grade
point are above the
measure point.

=N

If the sign is positive
the grade point are
below the measure
point.
Turn the telescope
until the height
difference (dHgt) is
zero, then repeat the
measurement

{ > Step 5}

The following result data are
stored in the internal memory:

Measurement data:

PtID: Point number

Hz: Horizontal angle

V: Vertical angle

HD: Horizontal distance
SD: Slope distance

dH: Height difference

Coordinates of new gradeline
point:

E: Easting
N: Northing
H: Height

Grades Result:

daH: Stake out height
difference

daHD: Horizontal distance
along the foresight
line

Grd: Slope gradient

GE: Grade elevation
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Introduction

"Offset" application is generally
used to obtain sections of the
tunnels for volume computation
as well as mapping of the
tunnels. It allows users to input
offset value (left, right, up and
down) and computes after
measurement the actual
coordinates of the tunnel walls.

Backsight Point

Station

Foresight Point

TPS400 Mining Manual-1.0.0en

£
Known: Unknown:
» Coordinates of station * Point coordinates of the
+ Coordinates of backsight tunnel walls
point
+ Offset value
|23 Offset




Start and execution Offset

You can start Offset either by Menu dialog of "FLP": Sample dialog:

selecting it in the program or

after measuring in the OFFSET

application "Front Line Pag". PtID : 100
Offset: 1.500 m

Ig, When you start it from CONTINUE WITH ... LEFT 4)

programs you have to
enter station data and
measure to back- and GRADES | OFFSET
foresight point first.

Hz B 123°12'36"

ERSICT B Enter a desired point
number (PtID) and

the offset value.

> Step 2 VSIS
for the offset
definition.

O (Left, Up, Right, Down)
<« (Left, Down, Right, Up)

Offset
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Start and execution Offset, continued

Definition of offset explained:

Mining_z10

Mining_z11

G ]  Aim at target point

and measure.

[MEASURE] or [DISTJ/[REC]

[EXIT]
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Measurement is
triggered and stored
in the internal
memory.

Leaves the
application Offset
and return to the
menu dialog of "FLP".

<=n

After storing, the
program returns to
the measuring
dialog.

If you want to
measure a new point

repeat BRI ol
until EESICT Y .

Offset



Results

Saving data

The following result data are
stored in the internal memory:

Measurement data: Offset information: Coordinates of new offset
PtID: Point number Offset: Offset value point:
Hz: Horizontal Angle OffsetDir: Offset direction E: Easting
V: Vertical Angle (left, up, right, down) N: Northing
HD: Horizontal distance H: Height
SD: Slope distance
Ig The measurement
data are already
corrected.

Offset
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Polar setout

This program calculates the
required elements to stakeout
points from coordinates or
manualy entered angles,
horizontal distances and
heights. Setting out differences
can be displayed continuously.

Setting out coordinates from

memory

Procedure:

4 Select the point.

[DIST] Starts measurement
and calculation of
the stake-out
elements.

[REC] Saves the displayed
values.

[B&D] Input direction and
Hz-distance of stake
out point.

[MANUAL] Enables simplified

input of a point
without ptID and
without the
possibility of storing

the data of the point.

Normal indication of polar setout
offsets dHz, dHD, ddH.

Point to
be setout

dHz: Angle offset: positive
if point to be set-out
is to the right of the

actual direction.

dHD: Longitudinal offset:
positive if point to be
setout is further

away.
Height offset:
positive if point to be
setout is higher than
measured point.

ddH:
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Orthogonal setout

Cartesian setout

The position offset between
measured point and setout point
is indicated in a longitudinal and
transversal element.

Actual

Point to

dLength: Longitudinal offset:
positive if nominal
point further away.
dTrav.: Transversal offset,

perpendicular to
line-of-sight: positive
if nominal point is to
the right of
measured point.

dHeight:
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Height offset:
positive if point to be
setout is higher than
measured point.

Setting out is based on a
coordinate system and the
offset is divided into a north and
east element.

Point to
be setout
Actual 1

N
/ +dEast = +dNorth
@%
T

dEast

Easting offset
between setout and
actual point.

Northing offset
between setout and
actual point.

Height offset:
positive if point to be
setout is higher than
measured point.

dNorth

dHeight:

Setting out



The application Tie Distance
computes slope distance,
horizontal distance, height
difference and azimuth of two
target points measured online,
selected from the Memory or
entered using the Keypad.
The user can choose between
two different methods:

@D Polygonal (A-B, B-C)
@D Radial (A-B, A-C)

Polygonal Method:

1.

SD 2-3

T303

Radial Method:
Slope distance 1-2

. N i Slope distance 1-3
S / Az 1
S Az T 2
» /
~t’¢ 4 /AZY-4— 3
ﬁfentre point

Slope distance 1-4

In principal both methods are

the same.

Any differences will be

described.

Procedure:

1. Determine first target
point.

[ALL] Starts measurement
to the target point.
[FIND] Searches internal

memory for point
entered.
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2. Determine second target
point.
Proceed as with first target
point.

3. Result is displayed.

Brg Azimuth between
point1 and point2.

dsD Slope distance
between point1 and

point2.

dHD Horizontal distance
between point1 and

point2.

ddH Height difference
between point1 and

point2.

Tie Distance



Softkeys - polygonal method:

[NewPt 1] An additional
missing line is
computed. Program
starts again (at
point 1).

[NewPt 2] Point 2 is set as
starting point of a
new missing line.
New point (Pt 2)
must be measured.

[RADIAL] Switches to radial
method.

Softkeys - radial method:

[NewPt 1]
[NewPt 2]

[POLY]

TPS400 Mining Manual-1.0.0en

Determine new
central point.
Determine new
radial point.
Switch to poly-
gonal method.

Tie Distance



Mining Editor

Introduction

"Mining Editor" (PC Program
Package) is a Windows-based
program used for the data
exchange between the TPS400
Series and the PC.

Installation on the PC

The installation program for the
"Mining Editor" can be found on
the CD-ROM supplied. Please
note that the "Mining Editor"
program can only be installed

under the operating systems MS

Windows 95, 98, ME, NT4.0,
WINDOWS2000, XP.

For the installation call program
"setup.exe" in the directory

"MiningEditor\Disk1" on the CD-

ROM and follow the onscreen
instructions to complete the
installation.

TPS400 Mining Manual-1.0.0en

Program content

The "Mining Editor" can be used
for the following purposes:

« Data Import & Export
Import and export fixpoint
files (ASCII format).

« Data Transfer between PC
and TPS400 instrument
Upload and download of
fixpoint files, upload of
tolerances, download of
measurement data and
conversion of measurement
data to various formats for
peg calculation and archiving.

Mining Editor



Program content, continued Practical Examples

» Define and upload The following pages of the * Example1:
Tolerances manual describe the Creating fixpoint files, Define
Defining tolerances, editing functionality of "Mining Editor" tolerances, Uploading them
tolerances (password with two practical examples. to the instrument
protected), uploading
tolerat]ces. o . Example2:

* Creating fixpoint files Importing of fixpoints in ASCII
Creating and editing of format

fixpoint files (Coordinates)
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First Example (Creating fixpoint files, define tolerances, uploading)

Creating fixpoint files Define tolerances

ERSCTOME  Open a new file: File > New LR E  Open tolerances:

BT WA Enter point number, coordinates, Options > Tolerances - Edit
backsight reference point, grade ERSICTWd  Enter a password.
elevation.

Create a new password:

Options - Password
FI.765 55.987 90.265 P100

883656  6£0.325 91.354 P101

Select a measuring sequence
(BFFB, BFBF or BBFF).

ERSICT ] Save the created coordinate list: B = Backsight point and F= Foresight
File > Save As |g’ éoint). g e 9
Ig’ In the fixpoint entry module, the ] Enter number of sets.

"Mining Editor" allows users to create,
view, modify and save coordinate lists.

| 33 | Mining Editor
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First Example (Creating fixpoint files, define tolerances, uploading), continued

Upload Fixpoints and LRSI Enter jobname,
Tolerances to the instrument operator and
comments.

|?’ Ensure that the unit |§ Operator and

setting on the comments are

instrument (Menu / optional.
All Settings / Unit
Settings) is identical TR Select a tolerance
to the units set in type.
the "Mining Editor"
(Options 2>
Settings).
> Step 5
a) Select a folerance type STl Oven a fixpoint file:
(Primary, Secondary, F,-r,)e > OpF;n
Tertiary).
- S1EW4  Choose Upload:
b) Enter the values for: i Data > Uzload

* Horizontal Angle Limit .
RS CTok]  Select a job.
» Horizontal Distance Limit !

* Height Limit

Mining Editor
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Second Example (Importing of fixpoints in ASCII format)

Process import fixpoint files

|g The "Mining Editor" allows to import

> Step 2
Steps

fixpoint files in ASCII format.

LGN E  File > Open

Open File

=N

Laok in I a ascii

= o) ol

[Z] 100 50001
[Z] 10000 b4 GRT_taam.ord

[Z] 100kepword. TXT ] 11.asc
2] 100mized THT testids
=] 20000 bt test? asc

test? tet

File name: ISwiss asc

Files of type: Al Files (7]

i
Open I
[[Eed |

Cancel

L

Tenmplate I <hone:

L
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Save the created file:
File - Save as

=l Stop 4

ASCII-File search and select.
Open the selected file.

Follow the wizard onscreen
instructions to produce the correct

Mining Editor



Leica Geosystems AG, Heerbrugg,
Switzerland, has been certified as
being equipped with a quality
system which meets the Internatio-
nal Standards of Quality Manage-
ment and Quality Systems (ISO
standard 9001) and Environmental
Management Systems

(IS0 standard 14001).
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Printed in Switzerland - Copyright
Leica Geosystems AG, Heerbrugg,
Switzerland 2003

Original text

/S0 9001/ 1S0 14001

Total Quality Management-
Our commitment to total customer
satisfaction

Ask your local Leica Geosystems
agent for more information about
our TAM program

(3
L
Geosystems

Leica Geosystems AG
CH-9435 Heerbrugg
(Switzerland)

Phone +4171 727 31 31
Fax +4171727 46 73
www.leica-geosystems.com
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